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Copyrights and Trademark Notices
Copyright 2015 by Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, 
Lightspeed, ScreenFlow, Switch, Vantage, Wirecast, GraphicsFactory, MetaFlip, and 
Split-and-Stitch are registered trademarks and MacCaption, e-Captioning, Pipeline, 
Post Producer, Tempo, TrafficManager, and VOD Producer are trademarks of Telestream, 
LLC. All other trademarks are the property of their respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All right 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
Explorer, SQL Server 2005|2008|Server 2012, and Windows Media Technologies are 
trademarks of Microsoft Corporation.
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SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge 
Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.
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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
Vantage Cloud User’s Guide



Copyrights and Trademark Notices
6 
Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Vantage Cloud User’s Guide
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Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Version 1.4

Part number: 168120

Date: August 5, 2015
Vantage Cloud User’s Guide
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Overview
Introduction
Vantage Cloud Subscriptions provide nearly immediate access to scalable, 
discretionary Vantage transcoding and workflows within a secure, hosted 
infrastructure. Vantage Virtual Domains of any scale are provisioned in minutes to add 
to your media production capacity at any time, and you only pay for what you use. 

This guide describes the Vantage Cloud Manager user interface that automates the 
provisioning and management of Vantage Virtual Domains and the supporting 
Amazon Web Services (AWS) infrastructure to deliver Vantage Cloud Subscriptions. 

If you are interested in creating your own application for integrating with Vantage 
Cloud, please refer to the Vantage Cloud API documentation and code samples on the 
Telestream Vantage Cloud Subscriptions Support web page. You will find other helpful 
resources there as well to help you get the most from Vantage in the Cloud:
http://www.telestream.net/telestream-support/vantage-cloud/support.htm

What’s in this Book?
This book is structured to bring you up to speed using Vantage Cloud Subscriptions in 
the fastest way possible. It begins with the preceding Quick Start, then a brief overview 
in this chapter, followed by more detailed chapters about how to install, configure, and 
use Vantage Cloud Virtual Domains.

These are the chapters included in the Vantage Cloud Subscriptions guide:

■ Overview

■ Installation and Startup

■ Using Vantage Cloud Manager

■ Vantage Cloud Manager Description

■ Troubleshooting Vantage Cloud Manager

■ Glossary

If you just want to get started quickly using Vantage Cloud Subscriptions, go to the 
Quick Start on the next page and follow the six steps listed there.
Vantage Cloud User’s Guide
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Quick Start
The six steps below help you quickly install Vantage Cloud Manager, configure a new 
Vantage Virtual Domain, and begin using Vantage Cloud Subscriptions. If you need 
more information, details are covered in the Installation and Startup chapter.

1. Sign up for an AWS account and credentials at http://aws.amazon.com.

2. Install Vantage Cloud Manager by downloading and running the software you 
received from Telestream. (To request the software, contact Telestream: http://
www.telestream.net/telestream-support/vantage-cloud/help.htm.)

3. Launch Vantage Cloud Manager, provide AWS Account information,  and click File > 
New Virtual Domain (or click the New Virtual Domain button ). Fill in the blanks:

– Enter Account name and AWS login credentials.

– Select the Endpoint (location) for the Virtual Domain and Services processors.

– Select Virtual Domain Instance Type and Service Instance Type.

4. Start the new Vantage Virtual Domain by selecting the domain in the left panel and 
selecting File > Start (or clicking the Start button ).

5. Click Actions > Remote Desktop (or the Remote Desktop button ) to access the 
Vantage clients and local storage in a Remote Desktop window.

6. Configure AWS S3 Storage and Vantage Workflows as the Installation and Startup 
chapter explains beginning on page 39.

What’s in this Chapter?
This chapter introduces Vantage Cloud Subscriptions and gives you a simple overview 
of its architecture and the background you’ll need to know in order to make it work. 

The following topics in this chapter introduce you to Vantage Cloud Subscriptions: 

■ What Are Vantage Cloud Subscriptions?

■ Using Vantage in the Cloud

■ Recommended Security Practices

■ Getting Started
Vantage Cloud User’s Guide
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What Are Vantage Cloud Subscriptions?
Vantage Cloud Subscriptions consist of two primary components: (1) the Vantage Cloud 
Manager local application for managing access to (2) Vantage Virtual Domains running 
in the Amazon Web Services cloud. Vantage Cloud Subscriptions include a version of 
Vantage installed in the cloud and accessed via the Internet.

When you establish an AWS account, Amazon gives you access to Vantage available in 
their cloud environment, running on servers located at points around the world. You 
can select the server location closest to you (known as an Endpoint) for best network 
performance, and you can select the computing and storage capability you want to use 
(known as an Instance Type). You get access to cloud-based bulk storage, known as S3, 
and shared storage within the virtual Vantage system for Vantage Stores.

AWS Cloud

User Premises

S3 Storage for 
Watch and 

Output Folders

Vantage Cloud 
Manager

Your local 
media file server

Internet

Remote Desktop 
Connection

Virtual Domain

ServicesDomain Instance

DB StoreS3
Vantage Cloud User’s Guide
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Vantage Cloud Manager and AWS Concepts
Before you begin using Vantage Cloud Subscriptions, you need to know how the 
Vantage Cloud Manager controls the AWS infrastructure and learn about the Vantage 
Cloud Subscriptions components, features, and capabilities. The following pages walk 
you through the concepts and commands you will use to access Vantage in the cloud.

Creating an AWS Account
Signing up for an AWS account causes Amazon to generate a user name, called an 
Access Key, and a password, called a Secret Access Key. These are your AWS login 
credentials and should be protected. You will insert these into fields in Vantage Cloud 
Manager so it can access AWS and set up Vantage Virtual Domains for you in the cloud.

Using Vantage Cloud Manager
To configure and manage Vantage Virtual Domains, you install the Vantage Cloud 
Manager local management application on your workstation. This application lets you 
establish your credentials for logging into Amazon, set the size and location of the 
computing resources you want to use, and create your own Vantage Virtual Domain in 
the cloud. 

Creating New Vantage Virtual Domains
You begin by defining the type and number of the AWS virtual machines that will be 
provisioned in your Vantage Virtual Domain.  The Vantage Cloud Manager application 
provides choices for the Domain Instance server size, and the Service Instances 
(transcoding nodes) server size so you can balance cost and scale to meet your needs.  
Once you have decided upon the server configuration, simply click the start button and 
Vantage Cloud Subscriptions builds the Vantage Virtual Domain and the IT 
infrastructure to support it.   
Vantage Cloud User’s Guide
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Starting a Vantage Virtual Domain
You have to start a Vantage Virtual Domain before you can use Vantage in the cloud. 

Starting a Vantage Virtual Domain in Vantage Cloud Manager causes AWS to create a 
Virtual Private Cloud (VPC). This is a virtual network on AWS with an Internet gateway 
and a block of IP addresses dedicated to your private cloud connections.

AWS also creates Elastic Compute Cloud (EC2) Instances within the VPC and makes all 
the necessary network connections and address assignments. AWS creates these 
Instances behind the scenes from Telestream-supplied templates called Amazon 
Machine Images (AMIs).  

An Instance is a virtual Windows server dedicated to running your Vantage software. It 
takes a Vantage Domain Instance to run the domain database and clients and another  
Vantage Service Instance to run the transcoder and other services. Cloud Manager lets 
you set the Instance Count to create multiple Instances for Services so you can 
distribute Vantage Services across multiple servers for efficiency.

During Vantage Virtual Domain startup, Vantage Cloud Manager displays notifications 
showing you each major step in the startup process. After the VPC, Instances, and 
Vantage components are started, your Vantage Virtual Domain is ready to use in the 
AWS cloud.

AWS Cloud

S3 Storage for 
Watch and 

Output Folders
Vantage Service
Instances (EC2)

Vantage
Domain Instance (EC2)

DB StoreS3

Virtual Private Cloud (VPC)
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Accessing Vantage in the Cloud
Once the Vantage Virtual Domain starts, you can use the Remote Desktop button in 
Vantage Cloud Manager to open a remote view of the Vantage Virtual Domain server. 
The Vantage Cloud Manager establishes a remote desktop session with your Vantage 
Virtual Domain using Remote Desktop Protocol (RDP). This protocol connects you to a 
virtual Windows desktop containing Vantage Workflow Designer, Vantage 
Management Console, a virtual C: drive for Windows and programs, and a virtual D: 
drive for the Input folder, Vantage Store, and other local storage. The Vantage client 
applications are already enabled for user administration and do not require a login.

The clients in the cloud are the same Vantage Workflow Designer, Management 
Console, and Web Apps that you would use in a local Vantage installation, and you use 
them in exactly the same way you always have. 

An Input folder and  Vantage Store are created on the D: Drive within the Virtual 
Domain and are required for input to and output from the Vantage Virtual Domain. 
Vantage Cloud User’s Guide
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Pausing a Vantage Virtual Domain
Vantage Cloud Manager lets you pause a running Vantage Virtual Domain. The paused 
state is useful when you will not be using the system for a few hours but you don’t want 
to shut the whole system down and risk losing important manual settings or spend the 
time to start up and configure a new domain.  

When you use Vantage Cloud Manager to pause a Vantage Virtual Domain, the Domain 
Instance continues to run, but the Service Instances are terminated. Amazon may 
continue to charge you at a reduced hourly rate. When you start the Vantage Virtual 
Domain again, the Service Instances are recreated, and you can resume where you left 
off. 

Stopping a Vantage Virtual Domain
When you are done using a Vantage Virtual Domain and want to shut it down, use the 
Cloud Manager Stop Virtual Domain command. When you stop a Vantage Virtual 
Domain, AWS terminates all Instances and deletes the VPC. AWS hourly charges should 
also stop.

Once the Vantage Virtual Domain stops, you can start it again by using a Start Virtual 
Domain command. Startup can take some time, so you may be better off pausing 
rather than stopping if you plan to be away from the system for a few hours or less.

Note: When you stop a Vantage Virtual Domain, changed service settings (service limits, 
variables for Run On Rules, Qualification Rules, etc.) are lost. When you pause a domain, 
service settings on Service Instances are lost but are retained on the Domain Instance).

Retry Pause and Retry Stop
If an initial attempt to pause or stop a Vantage Virtual Domain fails, use the the Retry 
buttons at least once to attempt the pause or stop command again. Multiple retries are 
recommended before you resort to the Force commands.
Vantage Cloud User’s Guide
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Using Force Pause and Force Stop
The Force Pause and Force Stop commands do the same thing as the regular pause and 
stop commands, but the Cloud Manager ignores any returned errors and continues to 
attempt to pause or stop the Vantage Virtual Domain. These commands are a last resort.

WARNING: Because errors are ignored when you use Force Stop, EC2 Instances and the 
VPC may not be terminated. If this happens, you will continue to accrue hourly charges 
from Amazon. If you use either of the Force commands, you should log into AWS and use 
the Amazon console to view and remove any unwanted EC2 Instances and VPCs.

Saving a Snapshot
Vantage Database Snapshots are a convenient way to take a snapshot (save the state) 
of Vantage workflows (local or virtual) and later import that snapshot into the Vantage 
database in a Vantage Virtual Domain. When you select the Save Snapshot button, 
everything required to recreate a fully functioning Vantage Virtual Domain is saved. See 
Creating and Using Vantage Database Snapshots for details.

Exporting a Vantage Virtual Domain
You may want to export a Vantage Virtual Domain. If so, Vantage Cloud Manager 
includes an Export Virtual Domain function that exports an XML file containing a 
description of the Virtual Domain, including state, configuration and status details, as 
well as required objects. This function does not save the state of Vantage but just saves 
the Vantage Cloud Manager configuration for a Vantage Virtual Domain. The Import 
Virtual Domain function lets you import an exported XML file to reconstitute a Virtual 
Domain. See Exporting and Importing Vantage Virtual Domains for details.
Vantage Cloud User’s Guide
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Using Vantage in the Cloud
The overall process for using Vantage in the cloud is essentially the same as using a 
local Vantage installation with some minor differences regarding storage. When you’re 
ready to put Cloud to work, this is the general procedure you will follow:

1. As part of configuration, you will create Watch and Output folders in your allocated 
Amazon AWS S3 storage. Vantage Cloud Subscriptions requires these folders to 
reside on S3. 

2. Next, you create workflows using your Vantage Virtual Domain, or use Vantage 
Cloud Manager to take a snapshot of the workflows on a local Vantage domain and 
import the snapshot into your Vantage Virtual Domain and activate the workflows.

3. Then you submit media to the Watch folder to start Vantage workflow processing.

4. Your workflows in the Vantage Virtual Domain will detect media coming in from the 
S3 Watch folder, localize the media files to an Input folder on the D: Drive of the 
Virtual Domain, and process the files.

5. The workflow output goes temporarily into a Vantage Store folder created 
automatically during installation on the D: Drive of the Virtual Domain.

6. From the D: Drive Vantage Store, the Vantage workflows copy or move processed 
media (and attachment) files to the S3 Output folder you created earlier.

7. Lastly, you can copy the processed media from your S3 Output folder to any 
preferred destination, such as your local media server or workstation. Just be sure 
that your file transfer method and destination are cloud-supported and accessible.
Vantage Cloud User’s Guide
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Recommended Security Practices
Security is vitally important, and using an application over the public Internet naturally 
raises concerns about security. Users can be assured that Vantage Cloud Subscriptions 
were designed with security in mind, and Amazon has designed the AWS Virtual Private 
Cloud environment to be generally safe and secure. Additionally, you can enhance 
security by applying your own corporate security policies, and by observing the 
following recommended practices.

How AWS Manages Security
• Restricts access to publicly accessible instances, and restricts who can access the 

publicly accessible instances by checking the caller's public IP address.

• Adds the public IP address of the server running Vantage Cloud when starting the 
Vantage Virtual Domain.

• When a Vantage Virtual Domain is exported and then imported, the new server’s 
public IP address is added during Virtual Domain startup (if different from the pre-
vious server).

• By default only the Domain Instance is publicly accessible. Service Instances 
become publicly accessible on the Internet only when starting an RDP connection.

Managing Security Risks
Vantage Virtual Domain configurations can be exported to an XML file. This makes it 
easy to return a domain to a specific state or to clone domains. Exported Vantage 
Virtual Domain data is encrypted for security, but it contains all of the AWS account 
information needed to access your Vantage Virtual Domains from any computer. Be 
very careful where you place exported XML files and how and to whom you send them. 
Sending these files is the equivalent of sending someone your AWS account password. 

To manage your security risks, observe these warnings:

SECURITY WARNINGS
• Export and import of Vantage Virtual Domains is for migration to new servers 

only, NOT for alternative access systems. 

• Exported Vantage Virtual Domains contain your AWS account information 
and enable access to Vantage Virtual Domains from any computer. Treat all 
exported Vantage Virtual Domains as securely as you treat your passwords.

• NEVER share your Vantage Virtual Domains.

• NEVER share your AWS credentials.
Vantage Cloud User’s Guide
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Configuring Your Network for Security
Telestream recommends the following network configuration practices:

• Establish a Vantage Cloud Subscriptions server within your enterprise security system.

• Only access your Vantage Virtual Domain directly from your secure server.

• Use a VPN connection to the server for remote access.

• Do NOT configure two servers for access to the same Vantage Virtual Domains.

Moving or Migrating Your Vantage Cloud Subcriptions Server
When moving a Vantage Cloud Subscriptions server, follow these practices:

1. Stop All Vantage Virtual Domains on the existing server.

2. Export all Vantage Virtual Domains from the existing server. Ensure the exported 
Virtual Domains do not leave your secure environment. 

3. Install the Vantage Cloud Manager software on the new server.

4. Import the exported Vantage Virtual Domains to the new server and make sure 
they work by starting and testing each one.

5. Uninstall Vantage Cloud Manager from the old server, and delete the folder and 
files in C:\ProgramData\Telestream\Vantage Cloud.

Accessing Your Vantage Virtual Domains Remotely
• Use a VPN connection to the server running Vantage Cloud Manager for remote 

access.

• To work with Telestream Support, allow remote access to the Vantage Cloud Virtual 
Domain server so Support sees the Vantage Virtual Domain from the system that 
created and manages it.

Getting Started
Now that you have a basic overview of how Vantage Cloud functions, you’re ready for 
the next step, which is installing and getting started using Vantage Cloud 
Subscriptions. 

Please go to the next chapter, Installation and Startup, which will guide you through 
installation, configuration, and logging in for the first time.

After logging in, you may want to read the chapter entitled, Using Vantage Cloud 
Manager on page 47 for procedures to use Vantage Cloud Manager with Amazon Web 
Services to access Vantage in the cloud.
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Installation and Startup
Introduction
This chapter explains how to provision and start Vantage Virtual Domains and begin 
using them. These topics are covered:

■ Prerequisites

■ Considerations

■ Installation and Configuration

■ Vantage Virtual Domain Recommended Practices

Prerequisites
The following are Vantage Cloud Manager requirements:

• Windows operating systems:

– Windows Server 2008 R2 (64-bit)

– Windows 7 (32-bit or 64-bit)

• Internet Explorer 10 or later, Safari 5.1.7 or later, or Chrome version 36 or later

• Internet connection

• Amazon Web Services (AWS) account

• Microsoft .NET 4.0 or 4.5.1 must be installed. The Cloud installer automatically
installs .NET 4.0 unless 4.5.1 is already present, in which case it leaves 4.5.1 in place.

• You must have administrator privileges to install Vantage Cloud Manager, but non-
administrators can run the application once it is installed.

• Vantage Cloud Manager communicates with the Virtual Domain using the follow-
ing ports. Please be sure these ports are open to Vantage Cloud in your firewall:

– TCP 80 (HTTP)

– TCP/UDP 3389 (RDP)

– TCP 8676/8677 (Vantage SDK)

– All ICMP (Ping)

– 43000 Vantage Cloud Manager REST API
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Considerations
Certain considerations and limitations apply to using Vantage Cloud Subscriptions:

• Vantage Virtual Domains do not support Active Directory user accounts.

• Vantage Cloud supports only one Vantage Cloud Manager connection at a time to a 
specific Vantage Virtual Domain. Multiple Manager connections to a single Vantage Vir-
tual Domain can cause inconsistency between Managers.

• On any single computer, you can run multiple Vantage Virtual Domains and Services.
Resource availability at AWS may be limited by your AWS account as described in
AWS Considerations. Vantage Cloud Manager will report that condition should it
occur.

• The Snapshot feature allows you to capture the Vantage workflows of a local or vir-
tual Vantage domain and import them into a Vantage Virtual Domain. This feature
works only if the local and cloud domains are exactly the same Vantage version.

AWS Considerations
• Performance varies by instance type (virtual server specifications) and network traf-

fic. Busier times of day may affect both server performance and transfer speeds.

• Virtual servers can become temporarily unavailable. Please see this URL for details: 
http://aws.amazon.com/ec2/faqs#How_many_instances_can_I_run_in_Amazon_EC2)

• AWS default account settings specify limits on various AWS resources.  Vantage Cloud 
Manager will report that condition when it is unable to create new Virtual Domains
due to lack of available resources.  AWS resource allocation can be increased by con-
tacting AWS support. AWS accounts have a default limit of 5 Virtual Private Clouds
(VPCs) per Endpoint, including one required Default VPC automatically established
for your account. See the AWS documentation page on Amazon Virtual Private Cloud
for details. Also see No VPC Available in the Troubleshooting chapter of this guide for
a discussion of the error message that is presented if you try to start too many VPCs.

• AWS accounts have a default limit of 5 external addresses (called elastic IP addresses
by AWS) per account per Endpoint. This limits the number of simultaneous Vantage
Virtual Domains and Remote Desktop connections you can have, each of which
requires one address. See the AWS documentation page on Elastic IP Addresses for
details.

• AWS may not be able to provide access to some Instance Types if those types are in
use by other customers. Cloud Manager displays a message when an Instance Type is 
unavailable. If you need a particular Instance Type, you may have to connect to a
more distant Endpoint or wait for a less busy time of day to access the desired
Instance Type. See the AWS page about Lightspeed GPU availability.
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Installation and Configuration
The six steps below help you quickly install Vantage Cloud Manager, configure a new 
Vantage Virtual Domain, and begin using Vantage Cloud Subscriptions. 

These are the six steps:

1. Sign up for an Amazon AWS Account

2. Install and Run the Vantage Cloud Manager

3. Configure a New Vantage Virtual Domain

4. Start the Vantage Virtual Domain

5. Start the Remote Desktop

6. Configure AWS S3 Storage and Vantage Workflows
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Sign up for an Amazon AWS Account
a. Point your browser to http://aws.amazon.com.
b. Follow the AWS procedure to sign up for an AWS account and obtain login

credentials.
c. Register for the Vantage Cloud Domain and Vantage Cloud Transcode AMIs

within your AWS Marketplace account.
d. Note your account information, including the cloud service login and password,

called Access Key ID and Secret Access Key by Amazon. Amazon also offers IAM
subuser accounts for multiple users. See the AWS IAM documentation for details.

When creating subuser accounts, the following minimum IAM permissions are
required.

IAM permissions to run Vantage Cloud Subscriptions:

{
  "Statement": [

 {
   "Effect": "Allow",
   "Action": [
     "ec2:AllocateAddress",
     "ec2:AssociateAddress",
     "ec2:AssociateDhcpOptions",
     "ec2:AssociateRouteTable",
     "ec2:AttachInternetGateway",
     "ec2:AuthorizeSecurityGroupIngress",
     "ec2:CreateCustomerGateway",
     "ec2:CreateDhcpOptions",
     "ec2:CreateInternetGateway",
     "ec2:CreateKeyPair",
     "ec2:CreateNetworkAcl",
     "ec2:CreateNetworkAclEntry",
     "ec2:CreateRoute",
     "ec2:CreateRouteTable",
     "ec2:CreateSecurityGroup",
     "ec2:CreateSubnet",
     "ec2:CreateTags",
     "ec2:CreateVpc",
     "ec2:DeleteCustomerGateway",
     "ec2:DeleteDhcpOptions",
     "ec2:DeleteInternetGateway",
     "ec2:DeleteKeyPair",
     "ec2:DeleteNetworkAcl",
     "ec2:DeleteRoute",
     "ec2:DeleteRouteTable",
     "ec2:DeleteSecurityGroup",
     "ec2:DeleteSubnet",
     "ec2:DeleteTags",
     "ec2:DeleteVpc",
     "ec2:DescribeAddresses",
     "ec2:DescribeAvailabilityZones",

 
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     "ec2:DescribeDhcpOptions",
     "ec2:DescribeInstanceStatus",
     "ec2:DescribeInstances",
     "ec2:DescribeInternetGateways",
     "ec2:DescribeKeyPairs",
     "ec2:DescribeNetworkAcls",
     "ec2:DescribeRouteTables",
     "ec2:DescribeSecurityGroups",
     "ec2:DescribeSubnets",
     "ec2:DescribeTags",
     "ec2:DescribeVpcs",
     "ec2:DetachInternetGateway",
     "ec2:DisassociateAddress",
     "ec2:DisassociateRouteTable",
     "ec2:GetPasswordData",
     "ec2:ModifyVpcAttribute",
     "ec2:ReleaseAddress",
     "ec2:RunInstances",
     "ec2:TerminateInstances"
   ],
   "Resource": [
     "*"
   ]
 }

  ]
}

IAM permissions to use S3 protocol with Vantage:
{
  "Statement": [

 {
   "Effect": "Allow",
   "Action": [
     "s3:DeleteObject",
     "s3:GetObject",
     "s3:ListAllMyBuckets",
     "s3:ListBucket",
     "s3:PutObject"
   ],
   "Resource": [
     "*"
   ]
 }

  ]
}
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Install and Run the Vantage Cloud Manager
Follow these steps to install Vantage Cloud:

a. Choose a Windows 7 or Windows Server 2008 R2 computer where you can install
Vantage Cloud. The system must have Internet access to AWS at http://
aws.amazon.com.

b. Download the Vantage Cloud Manager software from Telestream to your
Windows computer. (To request the software, access this URL from your browser: 
http://www.telestream.net/telestream-support/vantage-cloud/help.htm.)

c. Double-click the VantageCloudSetup[version].exe file to launch the Vantage
Cloud installer. The installer opens to a Welcome page.


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d. Check the box that says I agree to the license terms and conditions.

e. Click Options to see the default installation location. You can leave this location
as is, or you can browse to change it. Click OK when finished.
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f. Click Install. Vantage Cloud Manager installs and a Success screen appears when
installation has finished.

g. Click Launch, or double-click the Vantage Cloud Manager desktop icon to start
the Vantage Cloud client.
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Configure a New Vantage Virtual Domain
Follow these steps to set up your Vantage Virtual Domain:

a. When you launch the application for the first time, a dialog box asks if you want 
to provide your account information now. Click Yes.

b. The Service Provider Accounts form opens and requests information so that 
Vantage Cloud Manager can log into your AWS account when you create 
Vantage Virtual Domains. 

Fill in the requested information as follows:

Account Name—Enter the name of the Cloud Service Provider account’s owner. 

Service Provider—AWS is the default selection.

AWS Access Key—Enter the Access Key ID assigned to you when you signed up for 
your AWS cloud services account (not the general login). 

AWS Secret Access Key—Enter the Secret Access Key assigned to you when you 
signed up for your cloud services account (not the general login password). 

(After you complete the form, you will not be asked again to create an account, 
but you can still access this form at any time by selecting it from the Tools menu.)

c. Click Validate to check your connection and credentials. A dialog box pops up to 
indicate success or failure validating the AWS login.

d. Click Apply and OK to save your account information and close the dialog box.

 
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e. Click the New Domain button (or File > New Virtual Domain) in the upper left 
corner of Vantage Cloud to create a new Vantage Virtual Domain. 

Note: Many commands are also available via context menus if you right-click in the left panel.

f. Click OK to create your new Vantage Virtual Domain.

Your new Vantage Virtual Domain Configuration appears in the client window. 

g. Check each detail of your Configuration and change any settings as you prefer. 
For a visual representation of what you are configuring, see the following block 
diagram. At a minimum you may want to check the following selections:

Virtual Domain Name—Change the default name to a unique name.

Service Provider—Shows your cloud Service Provider (AWS).

Account—The name you gave to your AWS account.

Endpoint—This is the location of AWS computing resources. Typically, you should 
use the Endpoint nearest to your S3 storage location for best network perfor-
mance. 

Domain Instance Type—Choose the virtual computing resource best suited to 
your task. At the right end of each selection, mouse over the blue “i” button to 
get a description of the AWS computing resource. 

More Info—Click this button to check the AWS information on the health (avail-
ability) of computing resources, pricing and configuration.  For example, if the 
Instance Type “i” button indicates the AWS resource is a “C3 Large,” click Service 
Health Dashboard, Instance Details, or Instance Pricing and look for “C3 Large” to 
get information about the availability, pricing, and description of that resource.

Click the New Virtual 
Domain button
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Vantage Database Snapshot—For the first use, this is set to [none], but you can 
create a snapshot of a local domain and deploy it to the Cloud if you wish. On 
future startups, you can select an existing snapshot to restore the Vantage Virtual 
Domain database to a previous setup or load a configuration from another Van-
tage domain. This makes it easy to save your operational state (workflows etc.) 
and return to it later. See Creating and Using Vantage Database Snapshots.

Service Instance Type—Choose the virtual computing capacity (AWS EC2 instance 
type) suited to your Vantage service task. Services include transcoding, notifying, 
etc. (Note that the Transport service is installed on the Domain Instance, not the 
Service Instances.) At the right end of each selection, mouse over the blue “i” but-
ton for a description of the AWS computing resource. Click More Info for details.

Some Endpoints may not offer the full range of computing capacities. If the com-
puting configuration you want is not available, try a different Endpoint. Also 
make sure the Instance Count is set to the number of Vantage service engines 
you want to use (the default is 1). 

AWS Virtual Private Cloud

Vantage Cloud 
Manager

Remote
Desktop

Vantage Virtual Domain

S3 Storage

S3

Internet Gateway

Domain Instance

DB Store

VDOMAIN Server

Service Instance

Transcode Server

Internet Connection

Endpoint

EndpointEndpoint

AWS Facilities
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Start the Vantage Virtual Domain
The controls for starting, pausing, and stopping your Vantage Virtual Domain look and 
work like DVD controls. If you hover the cursor over a control, a tool tip displays the 
function of the control. 

• Click the Start button (right arrow) to start your Vantage Virtual Domain. (If you 
have multiple domains listed in the left panel, first click the one you want, or Ctrl-
click or Shift-click to select multiple domains.) When the Vantage Virtual Domain 
starts, a VPC, EC2 virtual servers, and Vantage are provisioned, and Vantage Cloud 
becomes available to use.

• To pause your domain, click the Pause button (two vertical lines). This minimizes 
processing activity (stops transcoding while paused and minimizes hourly charges), 
but some hourly charges from the provider may still accrue. (Pausing offers the 
advantage of preserving your manual domain configuration, but stopping loses 
any manual domain configuration.)

• To stop your Vantage Virtual Domain, click the Stop button (square). This deacti-
vates the domain and stops hourly charges at AWS.

• To delete the Vantage Virtual Domain if you will never use it again, click Delete 
(trash can).

 

Click the Start button
to start the domain.

Click the Stop button to stop the domain.
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Start the Remote Desktop
Once you have established and started a Vantage Virtual Domain, you are ready to use 
the domain by starting a Remote Desktop session:

a. Click the Remote Desktop button, either in the left panel or the lower right panel.

b. Click Yes when the Remote Desktop Connection dialog appears. If you would like 
avoid this dialog in the future, you can click Don’t ask me again for connections to 
this computer.

 

Click Remote DesktopEnsure the Vantage Virtual 
Domain 
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A remote desktop window opens with icons for the Workflow Designer and the 
Vantage Management Console clients on the desktop. Notice also that you can 
click Start > Computer to access the C: drive and D: drive Vantage Virtual Domain 
drives. The D-drive includes Vantage Output and Vantage Store folders.

c. Double-click the Workflow Designer or the Management Console icon on the 
desktop to start the Vantage client that you want to use. The Vantage client 
applications are already enabled for user administration and do not require a 
login.

You use Vantage in the cloud in the same way you would use a local version. See 
the Vantage User’s Guide or the Vantage Domain Management Guide under the 
Help menus of the client applications if you need instructions. 

Vantage Virtual Domain 
client apps on the remote 
desktop

Click Start > Computer to open a window showing the 
virtual drives, including a C: drive and a D: drive 
containing a Vantage Store folder.
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Configure AWS S3 Storage and Vantage Workflows
Before you create Vantage workflows, you need to create Watch and Output folders in 
your AWS S3 storage location. You upload media from local storage to the S3 Watch 
folder for Vantage Virtual Domain processing. After processing, the Vantage Virtual 
Domain makes the media available to download from the S3 Output folder. 

To create Watch and Output folders and upload media, follow these steps:

a. Log onto AWS S3. The figure shows example S3 login screens. Note: For best 
performance, choose an S3 location near the Endpoint you plan to use; for 
example, set S3 and your Endpoint both for US East. For details about S3 setup, 
please refer to the AWS S3 online documentation.

 
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b. Use the S3 Create Bucket button to create Watch and Output folders (Amazon 
calls folders buckets). In the Create a Bucket dialog, select the same region as the 
computing resources you plan to use. (After creating a bucket, click it in the list of 
buckets and click Properties to set permissions and any other desired properties.) 

c. When you run Vantage in the Vantage Virtual Domain, specify the Cloud Service 
Provider (AWS) in the Watch action File System inspector window, and in the next 
window, provide the folder location and credentials Vantage will need for 
accessing the storage folder. The figure shows AWS S3 storage selected. 
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d. When your workflows are activated, copy media for processing into your new 
AWS S3 Watch folder. As the figure shows, in AWS, you click a bucket to open it, 
and then use the Upload button to put media files into the Watch folder (bucket) 
from your local machine or networked server. 

Note: Transcoding directly from S3 object storage is not supported.  Files must 
be localized to the shared block storage within the Vantage Virtual Domain. See 
the following Vantage Virtual Domain Recommended Practices for details about 
how to use S3 and how to localize files before transcoding.
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Vantage Virtual Domain Recommended Practices
The following topics offer recommendations for working with Vantage Cloud.

Workflow Recommended Practices
Follow these steps (shown in the figure below) when constructing workflows:

1. Upload your original media files into AWS (S3) Storage. 
Your Vantage Virtual Domain workflow Watch action has built-in support for this 
storage and can directly monitor the S3 storage location (Input Watch bucket) you 
specify for the arrival of new files. 

2. Move or Copy your media from S3 to the Vantage Virtual Domain D: drive. 
This is shared storage mapped to the D: drive of all of the instances. Folders on this 
shared drive should be referenced with UNC path names in Vantage workflows.  
The system is configured with a default folder: \\VDOMAIN\Vantage Store\. 

Your workflows should begin with a Copy action to localize files from your S3 Stor-
age Input Watch bucket to your shared folders on the virtual SAN. Both the Move 
and Copy actions have built-in support for moving files to or from S3. 

3. Do all transcoding (Flips) from Vantage Virtual Domain (D: drive) Storage. 
The D: drive on the domain server is configured as a SAN and shared to the servers 
in the Vantage Virtual Domain. Use the pre-configured folders or create your own.  
Folders should be accessed using UNC references, such as \\VDOMAIN\Media Local.

4. Copy or Move the transcoded media to AWS S3 Storage 
Copy from the Vantage Store folder on the virtual shared SAN to your S3 Output 
bucket. You can then migrate the output from S3 to any networked location.

Note: Do not use Amazon TntDrives for Watch folders because files may be detected 
multiple times each time you access the folder. Instead, use the integrated S3 
functionality in the Vantage Copy, Move and Colocate actions.
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Stores Recommended Practices
Vantage Virtual Domains are configured with a default Vantage Store for receiving 
processed outputs. You can create additional stores as needed. When stores other than 
the Vantage Store are exported in a domain snapshot and then reimported, the stores 
are re-created in an offline state. This may cause workflows using those stores to fail.

To prevent problems caused by offline stores, set Vantage actions to Use Available Store. 
This allows Vantage to use any available Store for outputs, preventing workflows from 
failing because their original store is not online. You can also bring stores online using 
the Vantage Management Console > Storage selection.

AWS S3 Recommended Practices
The following caveats apply specifically to using AWS S3 for media storage: 

• S3 is an object storage file system designed for files to be read and written in their 
entirety, not updated in place. Therefore, Vantage workflows must localize media 
files to Vantage Virtual Domain shared storage using Move or Copy actions.

• Be sure input nicknames for transcoding and analysis actions reference the local-
ized media on the D: drive. 

Preventing S3 Transfer Failures
Use Vantage Copy, Move and Colocate actions to access content in S3 buckets. To do so, 
configure folders in the Vantage Management Console that reference S3 buckets. 
Because of the variable nature of transfer speeds in the cloud, transfers from S3 may 
produce Vantage job failures that can be resolved by a retry.  When setting up a Copy 
action to transfer media from S3, set the default number of retries to 3.  This ensures 
transfers repeat until they complete without manual intervention.

If you experience more than 3 transfer failures in a row, confirm that the source material 
is completely present and not being accessed within S3.  If you continue to get failures, 
contact AWS Support to be sure the S3 bucket (folder) is working correctly.
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Performance and transfer speeds in the cloud can be highly variable; for example, 
transfer speeds between VPCs and S3 buckets may range from 1 Mb/s to 400 Mb/s. For 
best performance, follow these suggestions:

• Use S3 buckets and Vantage Virtual Domains in the same Endpoint whenever pos-
sible. Using different endpoints sometimes results in poor performance.

• Use parallel transfers to and from multiple buckets simultaneously. You can have 
many jobs running at a time with the Vantage Transport service session limit set 
high. (Session Limits can be set on the Setup tab for each service within the Van-
tage Management Console when the service is in maintenance mode.)

• Name S3 buckets with different first letters. 

Other Localization Methods
The S3 interface has been added to Vantage to provide native AWS object storage for 
moving media in and out of Vantage Virtual Domains. This makes it easy and simple to 
use a Vantage Virtual Domain.

However, Vantage Cloud Subscriptions supports network accessible storage with the 
same built-in protocols that a local Vantage installation supports. Therefore, you can 
use any networked storage and transfer protocol that is supported by both Vantage 
and Amazon. For example, you could use FTP servers or high-speed transfer servers 
such as Aspera or Signiant.
Vantage Cloud User’s Guide



Installation and Startup 
Adding Subnets

45
Adding Subnets
Amazon AWS allows you to create additional subnets within the Virtual Private Cloud 
that can interact with the Vantage Cloud subnet. This can be useful if you have 
hardware or software that must be installed on its own subnet.

Approximately 768 IP addresses are available for subnets in addition to the 254 
addresses used by Vantage Cloud out of the 1022 total addresses available in the VPC.

For instructions in setting up subnets, please see these AWS help pages:

• How to configure VPCs and subnets: 
http://docs.aws.amazon.com/AmazonVPC/latest/UserGuide/VPC_Subnets.html

• An example of subnetting for a database instance: 
http://docs.aws.amazon.com/AmazonRDS/latest/UserGuide/USER_VPC.html

For administrators only, the following steps summarize an example procedure:

1. Launch a Vantage Virtual Domain.

2. Create a new subnet in the AWS console with the CIDR block 10.0.1.0/24. Note that 
IP address blocks cannot overlap among subnets. 

3. Set the route table of the new subnet to that of the subnet created by Vantage 
Cloud. (Important: please see the note below for details about route tables.)

4. Launch a new service instance in the same VPC, using the second subnet (also 
check the box to automatically assign a public IP address).

5. Use Remote Desktop to access the new service instance.

6. Open a file browser and navigate to \\VDOMAIN\ to ensure you can access the 
shared drives in the Vantage Virtual Domain.

Note: In this example, stopping the Virtual Domain in Vantage Cloud Manager will 
terminate Vantage Cloud Virtual Domains as well as any manually added subnets. It is 
recommended that you manually remove added subnets before stopping the Virtual 
Domain. Otherwise Vantage Cloud will generate an error when it tries to remove the 
route table, which is reused between the subnets. Alternatively, you can create a 
separate route table for each subnet.
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Manager
Introduction
This section presents Vantage Virtual Domain concepts followed by common 
procedures that you may need to perform using Vantage Cloud Manager.

These topics are covered:

■ Creating and Using an Amazon AWS Account

■ Creating and Managing Vantage Virtual Domains

■ Exporting and Importing Vantage Virtual Domains

■ Creating and Using Vantage Database Snapshots

■ Creating or Changing Accounts

■ Changing Instance Type

■ Monitoring Vantage Virtual Domain Status

■ Playing Back Proxies Using the Workflow Portal

■ Using Retry for Failed Jobs

■ Updating Cloud Manager

■ Uninstalling Cloud Manager
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Creating and Using an Amazon AWS Account
In the interest of brevity, details about using Amazon AWS are not presented in this 
guide because Amazon provides their own helpful and thorough online instructions: 

http://aws.amazon.com/documentation/

To use Vantage Cloud Subscriptions with Amazon, you need to be able to use these 
AWS features and components, as documented by Amazon: 

Topic Amazon Link

Get an overview and create an Amazon 
AWS account

http://aws.amazon.com/

Get an IAM Access Key ID and Secret 
Access Key

http://docs.aws.amazon.com/IAM/latest/
UserGuide/ManagingCredentials.html

Use the AWS Management Console http://docs.aws.amazon.com/
awsconsolehelpdocs/latest/gsg/getting-
started.html

Use Amazon S3 storage http://aws.amazon.com/documentation/
s3/

Use AWS VPC http://aws.amazon.com/documentation/
vpc/

Specific instructions related to using Vantage Cloud with Amazon may be added here 
as needed.
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Creating and Managing Vantage Virtual Domains
Detailed instructions for creating and starting a Vantage Virtual Domain and Remote 
Desktop are covered in the Installation and Startup at the front of this guide:

■ Configure a New Vantage Virtual Domain

■ Start the Vantage Virtual Domain (Also see this topic to pause or stop.)

These are the basic steps to create and start a Vantage Virtual Domain:

1. Click the New button on the toolbar, or select File > New Vantage Virtual Domain.

2. Fill in the Manage Cloud Service Provider Accounts window and click OK.

3. Fill in the fields and make selections in the Configuration panel.

4. Select the Vantage Virtual Domain in the left panel, and click Start on the toolbar. 

5. After the Vantage Virtual Domain starts, click Remote Desktop to access the Vantage 
client apps, which are enabled for user administration and do not require a login.

Once they are created, Vantage Virtual Domains appear in a list in the left panel of the 
Vantage Cloud Manager display. Click any Vantage Virtual Domain in the list to make it 
the active domain that is controlled by the tools, menus, and panels. For detailed 
descriptions of the Vantage Virtual Domain tools, menus, and panels, please see the 
Vantage Cloud Manager Description chapter on 47.

When you create a Vantage Virtual Domain, you are setting up the configuration that 
you want in Vantage Cloud Manager. Nothing is created in the cloud and no hourly 
charges accrue until you start the Vantage Virtual Domain. After starting, the Vantage 
Virtual Domain runs within an AWS Virtual Private Cloud (VPC), the Service Instances 
run on AWS EC2 instances, and AWS begins charging you for those resources. 

Vantage Virtual Domain Configuration and 
Status details appear in the right panel.

Vantage Virtual Domains are 
listed in the left panel.

New Vantage 
Virtual Domain 

Start button

Remote
Desktop button
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Exporting and Importing Vantage Virtual Domains
You can export a Vantage Virtual Domain to an XML file (with a .vvd extension) and import 
it later to restore the domain to its previous state or to configure a new Vantage Virtual 
Domain. An exported Vantage Virtual Domain file contains a complete description of the 
Vantage Virtual Domain, including state, configuration and status details, as well as any 
objects on which the Vantage Virtual Domain depends. An export is not the same as a 
snapshot and does not include the Vantage database, workflows, or workflow components.  
However, if a Vantage Virtual Domain was configured from a snapshot, the snapshot is 
included in the export and can be included in an import.

Vantage Virtual Domains cannot be exported while in transition, such as from Started to 
Paused or Stopped. They can be exported only while the Vantage Virtual Domain is in a 
stable state. Only one user per active Vantage Virtual Domain is allowed when exporting. 
Secure information, such as the “AWS Secret Access Key,” is encrypted. 

Exporting a Vantage Virtual Domain
To export a Vantage Virtual Domain description file, follow these steps:

1. Ensure the Vantage Virtual Domain is in a stable state, not in transition between states.

2. Select a Vantage Virtual Domain from the domain list in the Vantage Cloud Manager.

3. Select File menu > Export Virtual Domain.

4. Browse to place the exported file on your local computer or a network share.

5. Click Save to save the file to the chosen location.

Importing a Vantage Virtual Domain
To import a Vantage Virtual Domain description file, follow these steps:

1. Select a Vantage Virtual Domain from the domain list in the Vantage Cloud Manager 
left panel.

2. Select File menu > Import Virtual Domain.

3. Browse for the location of the previously exported file.

4. Click Open to restore the domain to the state described by the file.

Note: If you export a Vantage Virtual Domain while it is running (Started), and then 
stop or force stop the Vantage Virtual Domain before importing to a new location, you 
will need to go through the special sequence below when you do the import. 

Importing a Stopped Vantage Virtual Domain
To import a Vantage Virtual Domain description file from a Vantage Virtual Domain that 
was stopped or force stopped after exporting, follow these steps. (This procedure is not 
necessary if the Vantage Virtual Domain was exported while stopped or while running 
and it is still running.)
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1. Import the exported Vantage Virtual Domain.

2. Status reads Started [Disconnected].

3. The Vantage Virtual Domain reconnects to AWS automatically after a brief delay.

4. An error message appears: No VPC correctly tagged in the Vantage Virtual Domain with id <ID>.

5. Click Force Stop and wait for the Vantage Virtual Domain to completely stop.

6. Click Start.

Creating and Using Vantage Database Snapshots
Vantage Database Snapshots are a convenient way to take a snapshot (save the state) of a 
Vantage database (local or virtual) and later import that snapshot into the Vantage 
database in a Vantage Virtual Domain. This leads to a consistent Workflow Designer state. 
(Note, however, that snapshots do not include Job Status or the state of workflows--
locked, activated, etc.)

You can save snapshots by name, so you can create them as often as you like, uniquely 
identifying each one. Additionally, you can check an Automatically Save option to 
automatically save a snapshot each time the Vantage Virtual Domain stops. 

These items from the Vantage system are captured by the snapshot:

• Workflows

• Workflow Categories

• Catalogs and Folders

• Stores and Output Folders

• Media and Attachment Nicknames

• Metadata Labels

• Variables

• Run on Rule Variables

• Services Settings: Storage and Qualification Rules

• Settings & Options: General, Email, Authorization, Signiant, Agility ECS

• Stylesheets

• Application Configurations (Job Status Views, Workflow Portal, Dublist Portal)

• Reports (Job and Service)

• Fulfillment Schemes

Everything required to recreate a fully functioning Vantage Virtual Domain is saved. For 
a list of items not saved in snapshots, please see the topic, Items Not Included in 
Snapshots, in the Troubleshooting Vantage Cloud Manager chapter.
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Saving a Snapshot
For steps to create a snapshot of a local Vantage domain (a domain that is not in the 
cloud), please see Creating Local Snapshots. The following steps explain how to create a 
Vantage Virtual Domain Database Snapshot:

1. Ensure your Vantage Virtual Domain is started. (You can’t take a snapshot of a 
stopped Vantage Virtual Domain.) 

2. Click the Status panel to make the panel visible.

3. Click Save Snapshot to save a snapshot using the displayed file name, which will 
overwrite the existing file. You can also enter a new Snapshot Name or use the drop-
down menu to select another existing snapshot name to overwrite. When you click 
Save Snapshot, the snapshot is saved to your local Vantage Virtual Domain drive.

CAUTION: If you save a snapshot using an existing name from the drop-down menu, 
the existing snapshot is overwritten and its data is lost—replaced by the new data.

Loading a Snapshot
At a later time, if you want to load a Vantage Database Snapshot to restore your 
Workflow Designer to a particular state, follow these steps:

1. Ensure your Vantage Virtual Domain is stopped. 

2. Click the Configuration panel to make the panel visible.

3. Select a snapshot from the Vantage Database Snapshot drop-down menu. 

4. Start the Vantage Virtual Domain. When the domain starts, it restores the Workflow 
Designer to the state stored in the snapshot.
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Managing Snapshots
Using the Manage Vantage Database Snapshots tool accessed via the Tools menu, you 
can manage snapshots of your local and Vantage Virtual Domains. You can rename, 
delete, or import snapshots, including importing snapshots from your local non-
Vantage Virtual Domains.

Note: In order to import snapshots from a local (non-virtual) Vantage domain, the 
local domain and the Vantage Virtual Domains must all be the same Vantage version. 
If not, the snapshot will not be created, and you will receive a failure message.

Renaming or Deleting Snapshots
To rename or delete a snapshot:

1. From the Tools menu, select Manage Vantage Database Snapshots. The Manage 
Vantage Virtual Domain Snapshots dialog opens.

2. Select the snapshot from the Snapshots drop-down menu in the dialog.

3. To change the name, type a new name in the Snapshot Name field, and click Apply. 
The snapshot name immediately changes, as reflected in the drop-down menu.

4. To delete a snapshot, click Delete, and answer Yes to the confirmation dialog.

5. Click OK to save and close the dialog.

Creating Local Snapshots
You can create snapshots of a local (non-virtual) Vantage domain so that you can use 
your workflows from that domain in your Vantage Virtual Domains:

1. From the Tools menu in Vantage Cloud Manager, select Manage Vantage Database 
Snapshots. The Manage Vantage Virtual Domain Snapshots dialog opens.

2. Click Create. The Create New Vantage Database Snapshot dialog opens. 
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3. In the Vantage SDK Host field, enter the server name or IP address where the 
Vantage domain SDK service resides. (To verify the host name, select Services in the 
Vantage Management Console and note the Machine Name for the SDK service.)

4. Enter a name for the snapshot in the Snapshot Name field, or select an existing 
snapshot from the drop-down menu.

5. Click Create to create the new snapshot from the local Vantage Domain. Once it is 
created, the snapshot is available in the drop-down list.

6. Click OK.

Creating or Changing Accounts
You can add or change accounts in the Manage Cloud Service Provider Accounts dialog.

Creating an Account
To create additional accounts with your Cloud Service Provider, follow these steps:

1. On the Configuration panel, click Manage Accounts (or Tools menu > Manage 
Cloud Service Provider Accounts). The Manage Cloud Service Provider Accounts 
dialog opens. 

2. Click New to clear the existing field contents. 

3. Enter an Account Name, select a Service Provider, enter the AWS Access Key, and 
the AWS Secret Access Key.

4. Click Validate to check that the credentials work. A message pops up to tell you 
whether the validation login succeeded. If it fails, check your login and password to 
ensure they are correct.

5. Click OK to save the new account and add it to the drop-down Account list.
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Changing an Account
To change the details of an account, follow these steps:

1. On the Configuration panel, click Manage Accounts (or Tools > Manage Cloud Service 
Provider Accounts). The Manage Cloud Service Provider Accounts dialog opens.

2. Make changes as desired to the Account Name, Service Provider, AWS Access Key, 
or the AWS Secret Access Key.

3. Click Validate to check that the credentials work. A message pops up to tell you 
whether the validation login succeeded. If it fails, check your login and password to 
ensure they are correct.

4. Click Apply to save the account changes, and click OK to close the dialog.

Changing Instance Type
To increase or decrease computing resources, you can change Instance Type in the 
Configuration panel while the Vantage Virtual Domain is stopped. The Domain Instance 
Instance Type sets the computing capacity and storage of computing resources for the 
Vantage Virtual Domain Database. The Service Instances Instance Type sets the 
capacity of the computing resources for the Vantage Virtual Domain services (for 
actions such as Watch, Flip, Move, etc.).

Simply select a different Instance Type from the drop-down menu, or change the 
Instance Count. For Service Instances changes, select Apply Changes (available only 
when the Vantage Virtual Domain is in the Started state). For Domain Instances, the 
changes are implemented when you start the Vantage Virtual Domain.

If you want more information about the Instance Type selection, mouse over the blue 
“i” button to get a description of the AWS computing resource. For additional details, 
click More Info. 

The More Info button provides links to AWS information on the health (availability) of 
computing resources, pricing and configuration. For example, if the Instance Type “i” 
button indicates the AWS resource is a “C3 Large,” click Service Health Dashboard, 
Instance Details, or Instance Pricing and look for “C3 Large” to get information about 
the availability, pricing, and description of that resource.

The Vantage Virtual Domain applies your changes, as indicated in the Status panel 
Service Instances and in the Vantage Virtual Domain State and Progress columns.
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Monitoring Vantage Virtual Domain Status
A number of tools are available to monitor Vantage Virtual Domain status. These 
include the Notifications and Services sections of the Status panel and the Web Apps 
(below).

Using Web Dashboard to Monitor a Domain
In the Status panel or the Vantage Virtual Domain panel, click the Web Dashboard 
button to open the standard Vantage Web Apps in your browser. 

To log in, enter this user name with no password: Administrator.

The Dashboard and Job Status apps show performance and job status details about the 
virtual Vantage instance. These are the same displays that are available with the 
standard Vantage product. For instructions, click the Web Help button on the front 
panel of each application. 

Viewing Notifications
The Notifications section of the Virtual Domain Manager Status display shows 
informational and warning messages about your Vantage Virtual Domains. Be sure to 
check these frequently.

Clearing Notifications
The Status panel Notifications section displays notifications about your Vantage Virtual 
Domain. If the list of notifications grows too long and you want to delete the 
notifications and start over, click the Clear Notifications button. The list clears 
completely.
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Viewing Service Instances
The Service Instances section of the Status panel displays the number of Vantage 
Virtual Domain instances and details about their connections, including when they 
were started. This allows you to track how much time you are using at AWS.

Dashboard Mode
Vantage Cloud Manager can be used as a dashboard for monitoring the health of 
Vantage Virtual Domains.  

Configure Dashboard mode from the Tools> Preferences > Dashboard check box.

Playing Back Proxies Using the Workflow Portal
The public IP address (referred to as an Elastic IP by AWS) varies for each Domain 
Instance. This means that if you want to use the Workflow Portal in a Vantage Virtual 
Domain to view proxies over the Internet, you must look up the IP address and enter it 
manually in Vantage as the HTTP alias of the Vantage Store where the proxies will be 
located. The following details explain how to set up proxy playback and how to 
manually enter the HTTP alias.

Playback of Vantage proxies entails these setup steps:

• Creating a Virtual Directory in IIS for the Vantage Store

• Creating an HTTP alias in the Vantage Management Console for the Vantage store

• Creating a Workflow Portal configuration

The Vantage Virtual Domain has a proper Virtual Directory in place for the Vantage 
Store, so the first item in the list above is already completed for you.

The second item requires that you manually create the HTTP alias to the Virtual Domain 
Vantage Store as follows:

1. In the Vantage Cloud Manager application, locate and note the public IP address of 
the Domain Instance listed in the Status section.

2. Open the Vantage Management Console.

3. Go to Storage > Vantage Stores.

4. For the Vantage Store (\\vdomain\Vantage Store\), type this into the Alias field:
http://[public IP address of the domain instance]/VantageStore/

See the example Alias entry in the following figure.
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The third item, creating a Workflow Portal configuration, is described in the Vantage 
Domain Management Guide. The process is the same as for a Vantage domain on your 
local premises. You can directly access this guide topic from the Vantage Management 
Console by clicking Application Configurations > Workflow Portal and then clicking the 
? icon in the upper right corner of the window. 
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Using Retry for Failed Jobs
For Conform, Flip, IPTV Flip, and Multiscreen Flip actions running on a Lightspeed 
server, Vantage Cloud is preconfigured to retry failed jobs.

These are the default retry settings:

• First retry: 10 seconds, 0 priority

• Second retry: 30 seconds, 0 priority

• Third retry: 1 minute, 0 priority

These settings are optimized for Lightspeed retry performance; however, you can alter 
them for any of the affected actions as follows:

1. In the Vantage Management Console components panel, open Workflow Design 
Items > Action Defaults.

2. Select an action in the Action Defaults details panel.

3. To disable retries, click No Retry.

4. To define a limited retry rule, click Limited Retry and complete the rule as follows:

a. For the first retry, specify the delay period number and units and priority.
b. For second and third retries, check the box and complete the rule configuration.

5. To define a recurring retry rule, click Recurring Retry and complete the rule:

a. Specify the delay period number and units and execution priority.
b. Clear the Stop after checkbox to enable unlimited retries, or check the box and 

specify a maximum number of retry iterations.
c. Click the Save button .
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Updating Cloud Manager
To update Vantage Cloud Manager, simply run the installer as described in the 
Installation and Startup chapter. The installer will guide you in completing the update.

During the update process, the Vantage Cloud Manager installer compares its own 
version and the installed version. If it detects an older installation, it will perform the 
update to the newer version. If it detects a newer installation, the installer will not 
complete the update.

Should you need to re-install an older version of Vantage Cloud Manager for some 
reason, the installer cannot be used to do the downgrade. You must first use Windows 
Control Panel > Programs and Features to remove the old version, and then use the 
appropriate installer to install the older version.

Uninstalling Cloud Manager
Follow these steps to uninstall the Vantage Cloud Manager application:

1. Stop all Vantage Virtual Domains (and delete them if they will not be used again.)

2. Close the Vantage Cloud Manager application.

3. To uninstall Vantage Cloud Manager, open Control Panel > Programs and Features. 

4. Select Vantage Cloud Manager, and right-click Uninstall. Follow the prompts. 

5. After removing the application, also delete the folder in 
C:\ProgramData\Telestream\VantageCloud. 
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Vantage Cloud Manager 
Description
Introduction
The Vantage Cloud Manager rapidly provisions Vantage domains within your Amazon 
Web Services account to provide immediate transcoding capacity. 

The following topics describe the Vantage Cloud Manager client features and functions 
in detail for your reference. These topics are covered:

■ Toolbar Buttons

■ Vantage Virtual Domain Buttons

■ Menus

■ Context Menu

■ Panels
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Toolbar Buttons
This topic describes the Vantage Cloud Manager toolbar buttons. 

These are the toolbar buttons, from left to right:

 Create—Configures a new Vantage Virtual Domain, which appears in the left panel. 
Click on the domain to highlight it and access its screens and menus.

 Delete—Deletes the currently selected Vantage Virtual Domain.

 Stop—Stops the selected Vantage Virtual Domain and stops hourly charges.

 Pause—Pauses the selected Vantage Virtual Domain and reduces but does not stop 
Cloud Service Provider hourly charges for services. 

 Start—Starts the selected Vantage Virtual Domain.

 Cancel—Cancels the current operation on the selected Vantage Virtual Domain.

 Force Stop (red)—Available when the Vantage Virtual Domain is in an error state and 
used only as a last resort (use Actions > Retry Stop instead). Forces the Virtual Domain to stop.

Note: Vantage Cloud attempts to delete all Vantage Virtual Domain components on a 
Force Stop, but it may not be able to delete everything. Check your Cloud Service 
Provider management to verify cleanup of all Vantage Virtual Domain components.

 Force Pause (red)—Only available when the Vantage Virtual Domain is in an error 
state and used only as a last resort (use Actions > Retry Pause instead). Forces the 
Vantage Virtual Domain to pause. The Cloud Service Provider may continue hourly 
charges for services at a reduced rate when the Vantage Virtual Domain is paused.

View—Turns Virtual Domain details on or off. Selects column or row display (or both).
 

The following details describe the View selections:

State—Shows the current state of the selected domain.
Progress—Displays a progress bar for the current action.
Details—Provides informational status messages.
Instances—Lists the number of the current Vantage Virtual Domain instances.
Notifications—Provides error notifications.
Endpoint—Displays the selected Endpoint for the Vantage Virtual Domain.
Connect—Displays the Web Dashboard and Remote Desktop connection buttons.
 Arrows—Expand or collapse the selected Vantage Virtual Domain display.
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Vantage Virtual Domain Buttons
Vantage Virtual Domains in the left panel contain their own buttons, including Save 
Snapshot, Web Dashboard, Remote Desktop, and an expand/collapse details arrow. 

The column headings are also buttons that control the order in which multiple Vantage 
Virtual Domains are displayed. Clicking on Name, State, or Progress reorders the list of 
Vantage Virtual Domains based on the column selected. An arrow appears at the top of 
the selected column to indicate the selected order, which has three states: default (no 
arrow), up arrow, and down arrow. The best way to understand the effect on ordering 
when you select a column heading is to try it and see the result. Three clicks on a 
heading returns you to the default order.

These buttons and an indicator, described left to right, are available in the Vantage 
Virtual Domain panels:

Save Snapshot—Saves a snapshot (captures the state) of the current Vantage Virtual 
Domain’s Vantage database at the time the snapshot is taken. Everything required to 
recreate a fully functioning Vantage Virtual Domain is saved.

When loaded into a Vantage Virtual Domain, a database snapshot restores the Vantage 
database in the Vantage Virtual Domain to the state the Vantage database (local or 
virtual) was in when the snapshot was taken—with certain limitations.  See Creating 
and Using Vantage Database Snapshots on page 51 for details and procedures.

Web Dashboard—Displays a Vantage Web Dashboard to monitor the state of the 
Vantage Virtual Domain and the jobs running on it. For details about using the Web 
Dashboard, see the documentation provided in the Web Dashboard Help menu.

Remote Desktop—Starts the Remote Desktop for the currently selected Vantage Virtual 
Domain(s). The Remote Desktop includes the Vantage client desktop icons which allow 
you to start the Vantage Virtual Domain clients.

Warning Notifications—The exclamation warning indicator turns yellow when there is a 
warning notification. You can view warning notifications in the Notifications section of 
the Status panel and use the Clear Notifications button in that panel to clear the 
Notifications list and the Notifications icon.

Arrow—Shows or hides the lower half (details) of the Vantage Virtual Domain panel.
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Menus
This topic describes the Vantage Cloud Manager top menu bar. Many of the menu 
selections provide alternative ways to access functions that are also available using the 
toolbar buttons:

File
Allows you to create, delete, import, and export Vantage Virtual Domains as well as 
close the Vantage Cloud Manager client.

New Virtual Domain—Creates a new Vantage Virtual Domain, which is listed in the left 
panel of the display, with domain details displayed in the right panel. Click a domain in 
the left panel list to select it.

Delete Virtual Domain—Deletes the currently selected Vantage Virtual Domain.

Import Virtual Domain—Imports a previously exported Vantage Virtual Domain.

Export Virtual Domain— Exports a Vantage Virtual Domain to an XML file. Vantage 
Virtual Domains cannot be exported while transitioning between states. 

Exit— Closes the Vantage Cloud Manager client.

Actions
Allows you to perform Vantage Virtual Domain actions, including stopping, starting, 
and pausing a Vantage Virtual Domain and managing certain Vantage Virtual Domain 
operations.
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Stop Vantage Virtual Domain—Stops the selected Vantage Virtual Domain, which also 
stops hourly charges from the Cloud Service Provider.

Pause Vantage Virtual Domain—Pauses the selected Vantage Virtual Domain, which 
may reduce but does not stop hourly charges from the Cloud Service Provider. The 
Vantage Database also remains intact, including any manual modifications.

Start Vantage Virtual Domain—Starts the selected Vantage Virtual Domain.

Cancel Operation—Cancels Vantage Virtual Domain startup (available only when 
starting).

Clear Notifications—Clears notifications from the Vantage Virtual Domain display.

Save Snapshot—Saves a snapshot of the Vantage database in the current Vantage 
Virtual Domain. Everything required to recreate a fully functioning Vantage Virtual 
Domain is saved. A snapshot can be loaded into a Vantage Virtual Domain to restore its 
Vantage database to the state that was recorded by the snapshot. See Creating and 
Using Vantage Database Snapshots on page 51 for details and procedures.

Web Dashboard—Displays a Vantage Web Dashboard, allowing you to monitor the 
state of the Vantage Virtual Domain. For details about using the Web Dashboard, see 
the documentation provided in the Web Dashboard Help menu.

Remote Desktop—Starts the Remote Desktop for the currently selected Vantage Virtual 
Domain(s). The Remote Desktop includes the Vantage client desktop icons which allow 
you to start the Vantage Virtual Domain clients.

Retry Stop, Retry Pause, Retry Start Vantage Virtual Domain— Reissues a stop, pause, or 
start command to the Vantage Virtual Domain if a prior attempt was unsuccessful. 

Force Stop, Force Pause Vantage Virtual Domain—Lets you force a Vantage Virtual 
Domain to stop or pause as a last resort if attempts using the other buttons or menus 
were unsuccessful. Always attempt a Retry command (listed above) before using a 
Force command. Force Stop provides a way to ensure the Vantage Virtual Domain is 
stopped. However, sometimes components are not deleted and hourly charges may 
still accrue. Use the AWS console to verify that all components of a force-stopped 
domain have been deleted, and delete them if necessary.

Reconnect—Reconnects to a started or paused Vantage Virtual Domain if there was an 
Internet disconnection or an error during an attempted reconnection. (Vantage Virtual 
Domains get disconnected if the AWS connection is lost or the Vantage Cloud Service is 
stopped and then restarted, such as during restart of a machine.)

Tools
Provides access to Provider Accounts, Domain Snapshots, and Preferences. 
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Manage Cloud Service Provider Accounts
Opens the Service Provider Accounts (login) window. The accounts created here appear 
as selections in the Cloud Service Provider Account drop-down menu.

Accounts: Lets you choose among several accounts that have been entered. Each time 
you create a new account, it goes into the list of available accounts in this drop-down 
menu. You can select the account, and all the details of the account are remembered.

Account Name: Enter any name you want to represent the current account entries. For 
example, if you have three company accounts for three different departments, you can 
give each one a meaningful name. Account names must be unique.

Service Provider: Select the Cloud Service Provider you want to use from the drop-down 
menu. At present Amazon AWS is the only supported provider.

AWS Access Key: Enter the cloud user login ID assigned to you by AWS.

AWS Secret Access Key: Enter the secret code supplied to you by AWS. 

Delete: Deletes the currently displayed account. (Caution: There is no undo.)

New: Starts a new account. Clears all data fields so you can start new entries.

Validate: Lets you test the connection and login. A message is returned telling you 
whether the login was successful or failed. If it failed, check your Login User Name and 
Password.

Cancel: Closes the dialog box and discards any changes.

Apply: Applies changes to the current account.

OK: Saves changes and closes the dialog box.
Vantage Cloud User’s Guide



Vantage Cloud Manager Description 
Menus

67
Manage Vantage Database Snapshots
Opens the window of the same name which allows you to create and delete snapshots 
of Vantage local domain and Vantage Virtual Domain databases (of the same Vantage 
version) and apply them to the database of the current Vantage Virtual Domain. 

The snapshot feature takes a snapshot of the Vantage database of the selected Vantage 
Virtual Domain and allows you to later load that snapshot into the Vantage database of 
a Vantage Virtual Domain or a local Vantage domain. Everything required to recreate a 
fully functioning Vantage Virtual Domain is saved. See Creating and Using Vantage 
Database Snapshots on page 51 for details and procedures.

These fields and buttons are available:

Snapshots: Lets you select an existing snapshot from the drop-down menu.

Snapshot Name: Displays the selected snapshot name, and allows changing the name.

Creation Date: Shows the date the snapshot was made.

Workflows In Snapshot: Lists the number of workflows in the current snapshot.

Virtual Domains Using Snapshot: Lists the number of domains using the snapshot.

Delete: Allows you to delete the current snapshot.

Create: Creates a new snapshot of the selected running Vantage Domain.

Cancel: Closes the dialog without saving changes.

Apply: Applies changes to the current snapshot.

OK: Saves changes and closes the dialog.
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Preferences
Allows you to configure your logging preferences for the Vantage Cloud Manager logs. 
The Preferences selections are shown and described below. Select the desired 
preferences and click OK to apply them or Cancel to leave them unchanged. 
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General Tab

Visual Experience Dashboard Look—Sets the look of the Vantage Virtual Domain state 
indication (started/stopped/paused). Unchecking the box (default) produces a small 
spot of color on the left side, and checking the box produces a band of color across the 
Vantage Virtual Domain corresponding to the state (see the figure below). The states 
and their colors are listed in Table 1.

Logging Tab Client Preferences

The Client Preferences listed below set your preferences for the client log file, which 
logs events related to the Vantage Cloud Manager and the selected Vantage Virtual 
Domain. 

Client Logging Level—Sets the logging level for the Cloud Manager application in general. 

Virtual Domain Logging Level—Sets the logging level for information related specifically 
to Vantage Virtual Domains.

Maximum Client Log File Size—Sets the size in characters of the client log file.

Client Log File Locate—Displays the Client log file path and opens the Windows file 
location of the client log when you click Locate. Double-click the log file to open and 
view it in your default text application, such as Notepad.

Logging Tab Service Preferences 

The Service Preferences listed below set your preferences for the Service log file, which 
logs events related to the Service Provider (Amazon).

Service Provider Logging Level—Sets the logging level specifically for AWS-related information.

Event Viewer Logging Level—Sets the logging level for the Windows Event Viewer.

Vantage Cloud Logging Level—Sets the logging level for the Vantage Cloud service in general. 

Table 1. Vantage Domain Status Color Display

State Color
Started Green
Paused Green
Stopped Gray
Transition Yellow
Error Red
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Maximum Service Log File Size—Sets the maximum size in characters of the service log file.

Service Log File Locate—Displays the Service log file path and opens the Windows file 
location of the log when you click Locate. Double-click the log file to open and view it 
in your default text application, such as Notepad.

Advanced Tab

The Advanced tab lets you change these items:

Data File Folder—Locates and displays the path to the Cloud Manager application’s data 
folder where cloud configuration and log files are placed. 

Reset Hidden Dialogs—Makes all dialogs visible again after they have been set to 
“Don’’t show this dialog again.” 

Clear Saved Host Addresses—Clears the Vantage SDK Host address saved in the Tools > 
Manage Vantage Database Snapshots > Create New Vantage Database Snapshot 
window. The affected field is the one outlined in red below. 

Help
Provides access to the Technical Support Information and About dialogs and this 
Vantage Cloud Manager User’s Guide. 

Get Technical Support Information—Opens the Technical Support Information win-
dow, which has multiple tabs for capturing information to send to Support. For 
details, please see the Troubleshooting Vantage Cloud Manager chapter.

About Vantage Cloud Manager—Opens an About dialog showing version informa-
tion and other details about the Vantage Cloud Manager software.

User Guide—Opens this Vantage Cloud Manager User’s Guide.
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Context Menu
To access the context menu, right-click on a Vantage Virtual Domain or the empty 
space in the left panel. The context menu is shown below, and the functions it accesses 
are the same as those described previously for the File and Actions menus. Please see 
those descriptions for details.
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Panels
This topic describes the Vantage Cloud Manager panels and their selections.

■ Configuration Panel

■ Status Panel

Configuration Panel
The Configuration panel allows you to set up your Vantage Virtual Domain, including 
selections related to the Virtual Domain, Cloud Service Provider, Domain Instances, and 
Service Instances.

Virtual Domain
The Virtual Domain panel specifies the details for the Vantage Virtual Domain you are 
currently accessing. You can give the Vantage Virtual Domain a name, determine the 
processing power, and load a Vantage Database Snapshot. 

Name—Accepts a Vantage Virtual Domain name of your choosing. Type a name and 
press Enter.

Version—Indicates the version of Vantage that your Vantage Virtual Domain is running.

Cloud Service Provider
The Cloud Service Provider section includes these selections:

Account—Allows you to use a drop-down menu to quickly select a provider account 
from accounts set up previously using the Manage Accounts button. 

Service Provider—Shows the Cloud Service Provider.

Endpoint—Lets you select the provider’s server location from a drop-down menu. You 
should generally choose the location nearest you for best performance. Also, you 
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should use the same Endpoint for the Vantage Virtual Domain and your AWS S3 
storage.

More Info—Displays links to AWS information on the health (availability) of computing 
resources, pricing and configuration. For example, if the Instance Type “i” button 
indicates the AWS resource is a “C3 Large,” click Service Health Dashboard, Instance 
Details, or Instance Pricing and look for “C3 Large” to get information about the 
availability, pricing, and description of that resource.

Manage Cloud Service Provider Accounts

The Tools > Manage Cloud Service Provider Accounts selection opens a dialog box, 
which allows you to enter or change the details of a new or existing account. 

Domain Instance
The Domain Instance panel specifies the details for the Vantage Virtual Domain you are 
currently accessing. You can select the computing capacity and load a Vantage 
database snapshot of a saved Vantage state into the Vantage Virtual Domain. 

Instance Type—Selects the virtual computing resource type and storage used for 
running the Vantage Virtual Domain. A lower capacity resource offers lower processing 
power and storage balanced by decreased cost and operating speed. A larger capacity 
resource offers greater processing power and storage with increased cost and speed. 

At the right end of each selection, mousing over the blue “i” button shows a description 
of the AWS computing resource. For more information about each computing resource 
and pricing, click More Info in the upper right corner of the Configuration panel.

Vantage Database Snapshot—Loads a previously taken snapshot of a Vantage domain 
database (either local or virtual). Use the drop-down menu to select the snapshot. For 
details and procedures about snapshots, see Creating and Using Vantage Database 
Snapshots on page 51. 

Automatically Save—Saves a Vantage Database Snapshot of your Vantage Virtual 
Domain automatically when you stop the Vantage Virtual Domain.

Service Instances
The Service Instances section allows you to select the type and size of virtual 
computing resources you want to use for the Vantage services.

Instance Type—Lists the type of virtual computing resources to be used for Vantage 
services. The drop-down menu lets you select the computing power and storage 
capacity. A lower capacity offers lower speed but also offers lower cost. A larger 
capacity resource offers greater speed and storage, but it costs more.

Note: Occasionally you may not find the resource you want on an endpoint. If a 
resource is not available, try processing at a less busy time or try a different endpoint.

At the right end of each Instance Type selection, mousing over the blue “i” button 
shows a description of the AWS computing resource. For details, click More Info in the 
upper right corner of the Configuration panel.
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Instance Count—Sets the number of transcoders and other Vantage services to be 
deployed in the Vantage Virtual Domain.

Apply Changes—Used while the Vantage Virtual Domain is running to change the 
number of running Service Instances in the Cloud. You can change the Instance Count 
configuration when the Vantage Virtual Domain is running, but the number of 
instances in the cloud  only changes after you click Apply Changes. This control is only 
available when a Vantage Virtual Domain is in the started state.

Status Panel
The Status panel displays information about the current state of the Vantage Virtual 
Domain, including Notifications, the current Domain Instance, and current Service 
Instances.

Virtual Domain
The Virtual Domain section displays information about the selected Vantage Virtual 
Domain.

Name—Displays the name of the Vantage Virtual Domain.

State—Shows the state of the domain, whether Started, Stopped, or Paused.

Details—Displays status messages about the Vantage Virtual Domain, including errors 
and the current step in the startup or stopping process.

Notifications
The Notifications section shows messages about Vantage Virtual Domain status. This 
section is most active during starting and stopping. Notifications can be copied to the 
clipboard using Ctrl-c. 
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Domain Instance
The Domain Instance section displays the address and computing resource size for the 
current Vantage Virtual Domain and also provides buttons to save a Vantage Database 
Snapshot, view the Web Dashboard, or open the Remote Desktop.

Public IP Address—Shows the IP address used to access servers for the current Vantage 
Virtual Domain. You can right-click this address and copy it to the clipboard. 

Host Name—Shows the host name of the Amazon virtual machine (Domain Instance) 
where the current Vantage Virtual Domain is running. Note: Do not change the host 
name.

Domain Instance Type—Displays the virtual computing capacity selected in the 
Configuration > Vantage Virtual Domain > Domain Instance Type field.

Save Snapshot—Saves a Vantage Database Snapshot of the current Vantage Virtual 
Domain. See Creating and Using Vantage Database Snapshots on page 51 for details and 
procedures. 

Web Dashboard—Displays a Vantage Web Dashboard to monitor the state of the 
Vantage Virtual Domain and the jobs running on it. For details about using the Web 
Dashboard, see the documentation provided in the Web Dashboard Help menu.

Remote Desktop—Starts the Remote Desktop for the currently started Vantage Virtual 
Domain. The Remote Desktop includes the Vantage client desktop icons which allow 
you to start the Vantage Virtual Domain clients.

Service Instances
The Service Instances section shows details about the Vantage services running in the 
current Vantage Virtual Domain. Details can be copied to the clipboard using Ctrl-c.

Host Name—Shows the Amazon virtual machine (Service Instance) host name where 
the current Vantage Virtual Domain services are running. Note: Do not change the host 
name.

Instance Count—Sets the number of Vantage service instances to be deployed in the 
Vantage Virtual Domain.

Internal IP Address—Shows the IP address of computing resources running the Vantage 
services for the current Vantage Virtual Domain.

Start Time—Shows the date and time that the current Vantage Virtual Domain was 
started.

Instance Type—Lists the type of virtual computing capacity to be used for Vantage 
service instances. The drop-down menu lets you select the computing power and 
storage. A smaller resource offers lower processing power and storage with decreased 
cost and speed. A larger resource offers greater capacity but higher cost.

Connect—Provides a hyperlink for launching the Remote Desktop.
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Troubleshooting Vantage 
Cloud Manager
Introduction
This section lists troubleshooting information and problems and solutions. 

■ Investigating Problems

■ Troubleshooting Specific Issues
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Investigating Problems
The following topics enable you to gather information about problems and possibly 
solve the problems yourself. If you are unable to solve a problem, the information you 
gather can be supplied to Telestream Support so they can help you resolve any 
problems.

■ Get Technical Support Information

■ Checking Logs

Get Technical Support Information
The Help menu includes a selection called Technical Support Information. This 
selection provides access to system and application information, including a System 
Profile, System Event Logs, Application Files (logs) and other tools and displays. 

A Save To Zip File button saves various logs and status documents to a zip file which 
you can save to your local system and forward to Telestream Customer Support for help 
with troubleshooting. 

System Services
The System Services tab provides information about the Vantage Cloud Service 
running on the local client computer, including whether the service is running, paused, 
or stopped, any exit codes in case of a crash, the process id, status, and so on.
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System Profile
The System Profile tab describes the client computer that is running the Vantage Cloud 
Manager application, including the Operating System and settings and Computer 
System hardware.

System I/O
The System I/O tab describes the logical and physical drives on your system as well as 
the keyboards and pointing devices.

System Network
The System Network tab lists your client computer’s network adapters, network 
protocols, and related settings.

System Event Logs
The System Event Logs tab displays a panel containing events that have transpired on 
your computer system. Check this log if an event occurs that seems to affect the entire 
computer, since every state transition of every device and process is recorded. If the 
Vantage Cloud Service fails to start altogether, the System Event logs are useful, as the 
file logs sometimes have not yet been created when the failure occurs. 

Application Profile
The Application Profile tab lists the name, location, and version of the Vantage Cloud 
Manager application. 

Application Files
The Application Files tab displays a panel that shows logs for the Cloud Manager 
application. 

Client.log

The client log notes Cloud Manager application events. If there are problems with the 
application itself, such as crashing, the events and causes may be recorded here.

Client.config

The Client.config panel shows configuration information about the Cloud Manager. 
This is useful to Telestream Support.

Service.log

The Service.log panel shows the interaction between the Cloud Manager and the Cloud 
Service Provider. If there are connection or interaction problems with the Service 
Provider, they may show up here.
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csp.xml

The csp.xml panel describes the Cloud Service Provider configuration as an XML file, 
including names, identifiers, and details for the Vantage Virtual Domain, Endpoints, 
Vantage Instance Image version, and so on.

Screenshot
The Screenshot tab takes and displays a screenshot of your Vantage Cloud Manager 
screen taken when you clicked on the Get Support Technical Information menu. You 
can also take your own screenshot by pressing Alt + Print Screen on your keyboard and 
then pasting the clipboard contents into a Paint or Word document.

Checking Logs
Logs for Vantage Virtual Domains are kept on the machine where Vantage Cloud is 
installed in C:\ProgramData\Telestream\Vantage Cloud\Logs\. These are the same logs 
that are available under Gathering Technical Support Information > Application Files. 
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Troubleshooting Specific Issues
The following topics list possible problems with Vantage Cloud and provide solutions.

■ Provisioning Error

■ Communication Error During Launch

■ No VPC Available

■ No Public IP Addresses Available

■ Requested Instance Type is Not Supported/Available

■ Orphaned VPCs and Instances

■ Snapshot Failure

■ Items Not Included in Snapshots

Provisioning Error
If the Vantage Cloud Manager returns an error when starting, pausing or stopping a 
Vantage Virtual Domain, please use an Action menu Retry command. The Force 
commands should be used only as a last resort.

Communication Error During Launch
This message appears when you launch Cloud:

A communication error has occurred with the Vantage Cloud Service. The 
application must exit.

The likely cause is an invalid service configuration affecting these files:

– C:\ProgramData\Telestream\Vantage Cloud\Service.config

– Any file in C:\ProgramData\Telestream\Vantage Cloud\Data

These troubleshooting steps may resolve the problem:

1. If there is a problem with C:\ProgramData\Telestream\Vantage 
Cloud\Service.config or C:\ProgramData\Telestream\Vantage Cloud\Data, you can 
delete the file or the folder and all files within it. Then uninstall and reinstall Cloud 
and launch it again.

CAUTION: Any accounts, snapshots, and Vantage Virtual Domains will be deleted if 
you delete the Service.config file or files in the Data folder. 

2. Look in the Help > Get Technical Support Information for entries from the source 
"Vantage Cloud Service." These logs often describe the problem in greater detail.

3. Sometimes the error message indicates a specific file that is causing the problem. 
Contact Telestream Support in this case. 
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No VPC Available
When Vantage Cloud Subscriptions deploys a Vantage Virtual Domain, it automatically 
creates a Virtual Private Cloud (VPC). Vantage Cloud Subscriptions also automatically 
deletes VPCs when a Vantage Virtual Domain is stopped. 

By default, an AWS account has a limit of 5 VPCs per account and Endpoint. One VPC is 
consumed by the AWS default VPC, which cannot be used for running a Vantage Virtual 
Domain. That leaves 4 VPCs available. If you are running 4 Vantage Virtual Domains at 
the same time, Vantage Cloud Manager presents this error message when you attempt 
to start a fifth Vantage Virtual Domain:

No VPC available. Aborting.

Possible solutions include stopping a Vantage Virtual Domain at the current Endpoint 
so you can start another one, launching a Vantage Virtual Domain at a different 
Endpoint, or requesting more VPCs and elastic IP addresses per Endpoint from Amazon.

Note: A Default VPC is required. If you don’t have one, you must request one from 
Amazon. Click this link for an overview and details about requesting a Default VPC.

No Public IP Addresses Available
You may receive this error Message: 

Remote Desktop Connection Failed. There are no available public IP addresses for 
this Vantage Virtual Domain....

The message indicates that all available access addresses are being used to service 
previous Vantage Virtual Domain instances and connections. You can free up an 
address by stopping another Vantage Virtual Domain.

By default, an AWS account has 5 access addresses (also called elastic IP addresses) 
available for use per Endpoint. When a Vantage Virtual Domain starts, the domain 
instance is assigned an access address, which is used for communication with the SDK 
service and Remote Desktop. The access address remains associated with the domain 
instance until the Vantage Virtual Domain is stopped.

If a user attempts to start a Vantage Virtual Domain when all access addresses are 
associated with running domain instances, the Vantage Cloud application displays an 
error message and does not allow the Vantage Virtual Domain to start until either an 
access address becomes available or the AWS account limit is increased.

When a Vantage Virtual Domain starts, service instances are not assigned an access 
address. An access address becomes associated with a service instance only when a 
user makes a Remote Desktop (RDP) connection request to a running service instance.

If all access addresses are in use when a user makes an RDP request to a service 
instance, an access address may be taken from another service instance. This will cause 
the RDP connection with another remote instance to drop in favor of the new RDP 
request. An RDP request to a service instance will not steal an access address associated 
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with a Domain Instance or with an EC2 instance in the AWS account that is not 
managed by Vantage Cloud (i.e. if an instance was created with the AWS EC2 
Management Console and not the Vantage Cloud application).

For Amazon's documentation on elastic IP addresses, see: http://
docs.aws.amazon.com/AWSEC2/latest/UserGuide/elastic-ip-addresses-eip.html.

Requested Instance Type is Not Supported/Available
Occasionally, an Instance Type may not be available on an endpoint because most or all 
systems of that type are in use. If the selected Instance Type is not available because it is 
in use by other customers, Cloud Manager displays an error message indicating that 
the requested instance type is not supported or not available. 

You can resolve an Instance Type limitation in any of these ways: 

1. Use another Instance Type if the type you requested is not essential.

2. Wait for the Instance Type to become available during less busy times.

3. Change your Endpoint to one that has the desired Instance Type available, and also 
change S3 to match the new Endpoint location to ensure best efficiency.

4. Contact AWS support and ask for an increase in the number of instance types. The 
instance type can be identified by mousing over the Instance Type in the Vantage 
Cloud Manager Configuration panel for the specified Vantage Virtual Domain.

Please see the AWS page about Lightspeed GPU availability.

Orphaned VPCs and Instances
When you use the Force Stop button to stop a Vantage Virtual Domain, the associated 
VPC (and possibly an EC2 instance) may be orphaned—not automatically deleted as 
they should be. If this occurs, the Vantage Virtual Domain Status Details panel provides 
a warning notification that resources could not be removed. The notification includes a 
VPC ID identifying the orphaned VPC. 

To resolve this issue, delete the VPC and EC2 instance manually on the AWS site:

1. Use your Web browser to log into the AWS Management Console.

2. Select EC2 from the Amazon Web Services list.

3. Select Instances in the navigation panel on the left.

4. Select the instance from the list, if it is still present, click Actions, and click Terminate. 

5. Click the orange cube icon in the upper left to return to the AWS console.

6. Select VPC from the AWS console list, and select Your VPCs from the left panel. 

7. Select the VPC whose VPC ID matches the one in the Status Details notification.

8. Click the Delete VPC button at the top of the VPC list to delete the orphaned VPC.

(This AWS Web page summarizes VPC and EC2 concepts: VPC Getting Started Guide.)
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Snapshot Failure
Snapshots require certain conditions to work properly. The most common requirement 
is that a local domain and a Vantage Virtual Domain must be the same Vantage version 
for a snapshot of the local domain to work. Additionally, if one of the issues below 
occurs, a snapshot may fail.

Run On Rule Error
If you import a workflow that uses Run on Rules (besides the Lightspeed Run on Rule) 
from an older version of Vantage into the current Vantage version and create a 
snapshot from this domain, the snapshot will fail to load. 

Workaround: Remove and re-apply the Run on Rule variable with the current Vantage 
version, and then re-create the snapshot.

Missing Items Error
If you create a workflow and then use the Vantage Management Console to delete any 
of the following items referenced by the workflow, a snapshot created from the domain 
will fail to load. 

• Variables

• Media Nicknames

• Attachment Nicknames

• Metadata Label

Workaround: Update the workflow to reference the missing items and re-create the 
snapshot.
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Items Not Included in Snapshots
When you import a snapshot, certain items may seem to be missing. For various 
reasons, a snapshot cannot include every single item in the Vantage domain database.

For example, Run On Rules are included in snapshots, but service variables associated 
with them are not (example shown below). You must reapply service variables to your 
Run On Rules manually.

Additional examples are stores, output folders, nicknames, labels, and variables, which 
are included in snapshots only if they are referenced by workflows. If any of these items 
exist in a Vantage domain but are not used in a workflow, they are not included in 
domain snapshots.

These are the items not included in snapshots:

• Licenses

• User created action templates

• Stores and Output Folders that are not referenced by workflows

• Media Nicknames that are not referenced by workflows

• Attachment Nicknames that are not referenced by workflows

• Metadata Labels that are not referenced by workflows

• Variables that are not referenced by workflows

• Action Defaults

Snapshots Containing Traffic or Third Party Actions Fail
Snapshots created from an on-premise Vantage domain that contains workflows with 
actions from any of the following services fail to load when starting a virtual domain:

• Agility

• Baton

• Aurora

• FileCatalyst

• Nexidia
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• Pulsar

• MediaMate

• Sigiant

• Traffic

• VidChecker

When this issue occurs, the Vantage Cloud Manager shows this error:

Error Starting

Error loading snapshot, unable to import workflow '[workflow]' into the Virtual Domain

Reason: The services listed above are not installed in Vantage Cloud Virtual Domains.

The workaround is to delete the actions for the services listed above in the on-premise 
domain and create a new snapshot. The snapshot that fails to load should be deleted.

Communication Failure with the Virtual Domain
If you try to connect with the Virtual Domain and experience communication errors, 
check your firewall. Vantage Cloud Manager communicates with the Virtual Domain 
using the ports listed in Prerequisites. Please be sure to open those ports in your firewall.

RDP Connection Failure
If you cannot connect to Vantage Cloud via RDP, check the following information.

When you establish an RDP connection to a Vantage Virtual Domain Instance, the first 
thing the Cloud Manager application does is check whether that instance will accept a 
TCP connection to the RDP port. 

If this test fails, the user will see the following message:

    “The instance is not yet ready to accept remote desktop connections.”

Often this means that the Vantage Virtual Domain Instance is not fully up and running 
yet. If you wait a little longer, you will be able to connect using RDP.

However, the TCP connection test to the RDP port may fail for these reasons as well:

• The instance has not launched completely. 
(Solution: Check the AWS console to verify status.)

• The instance does not have a public IP address. 
(Solution: Assign a public IP in AWS.)

• Your firewall is blocking connections to port 3389. 
(Solution: Open the firewall for this port.)
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Glossary
Amazon EC2
Amazon Elastic Compute Cloud.

Amazon Machine Image (AMI)
An AMI is a machine image of software configured on Amazon Cloud computing 
resources to allow users to use the software over the Internet as part of Amazon’s AWS 
cloud services. Vantage Cloud Subscriptions is installed as an AMI on Amazon 
computing resources.

AWS
AWS stands for Amazon Web Services. Through the AWS Web site, Amazon offers access 
to cloud applications, cloud storage, and many other services. Vantage Cloud is among 
the cloud applications available on AWS.

Bucket
A bucket is Amazon’s term for a folder or directory on AWS S3.

Client Machine or Workstation

A local Windows computer designed for individual use (not a server). Vantage Cloud 
Subscriptions uses an Internet-connected client workstation to run the Vantage Cloud 
Manager application used to manage Vantage Virtual Domains.

Cloud

The cloud is the term used to describe services and applications accessed via the 
Internet rather than installed locally on your computer. 

Cloud Manager
See Vantage Cloud Manager. 
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Cloud Service Provider
A Cloud Service Provider is a company such as Amazon that provides access to 
platforms, services, and applications in the cloud. Typically, users pay an hourly fee for 
general access and additional fees for specific services and applications.

D: drive
The Vantage Cloud Vantage Virtual Domain on AWS includes storage on the Windows 
D: drive accessible via the Remote Desktop (RDP) connection. This drive must be used 
for the Vantage Cloud Store—the temporary repository for Vantage Cloud 
intermediate outputs.

Endpoint
A physical location for cloud computing resources. When you create a Vantage Virtual 
Domain, you must specify an Endpoint where you want the Vantage Virtual Domain to 
run. Typically, you should use the Endpoint nearest you, but occasionally an Instance 
Type is unavailable because those resources are in use by other customers. In that case, 
you may need to use a different Endpoint to get the Instance Type you want.

GPU

Graphic Processing Unit. Hardware computing resources that are designed for 
graphics-intensive computing, such as transcoding video. In the cloud, GPU processing 
typically includes parallel processing using many computing cores.

Instance 

An instance is a virtual machine that can be provisioned and run at a Cloud Service 
Provider. A Domain Instance consists of a virtual machine running the Vantage domain 
database for a Vantage Virtual Domain. A Service Instance consists of a virtual machine 
running the Vantage Services (such as Transcoding) for a Vantage Virtual Domain. 

Instance Type
The Instance Type (such as Production, Production Large, Lightspeed, etc.) describes 
the capability of the individual Instances based on the needs of your Virtual Domain. 
The Instance Types available in Vantage Cloud map to hardware configurations for the 
Instances running in the Virtual Domain that are optimized for the given scenario.

Notification
A Vantage Cloud Notification is a message to the Vantage Cloud Manager user 
providing status information or warnings regarding the Vantage Virtual Domain.

Paused
One of three main stable states of a Vantage Virtual Domain. When paused, the Virtual 
Domain is suspended but still exists. From the paused state, the domain can be 
stopped or started.
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Public IP Address
A public IP address can be associated with a Domain Instance or a Service Instance to 
enable and identify connections to the instance from outside the Virtual Domain. Each 
Domain Instance uses and retains one public address as long as the Virtual Domain is 
paused or started. A Service Instance uses a public IP address if a connection to it is 
requested and may lose the address at any time to the connection request of another 
instance. Vantage Cloud manages public IP addresses automatically and does not 
normally require intervention unless the number of instances requesting connections 
exceeds the number of public IP addresses available from the service provider. For 
example, AWS limits the available public IP addresses to 5 by default.

 For more information, please see Amazon’s documentation: Amazon Elastic Compute 
Cloud.

Remote Desktop Protocol (RDP)
The protocol used to connect between your local computer and instances in the 
Vantage Virtual Domain. The client application is responsible for creating RDP sessions 
to grant users access to the Virtual Domain.

S3

Amazon Simple Storage Service (Amazon S3) provides Internet-based storage for your 
AWS account. S3 allows you to store any amount of data from any Internet location. S3 
includes its own interface accessible from the AWS Management Console. For Vantage 
Cloud, S3 is the location where you typically create your Watch and Output folders. Files 
on your local storage can be transferred to S3 Watch folders for transcoding, and 
transcoded outputs from Vantage Cloud go into S3 Output folders for transfer to your 
local storage. 

Service Provider Object Storage
The virtual storage volume available from the Service Provider, such as AWS S3 storage.

Snapshot
See Vantage Database Snapshot.

Started

One of three main stable states of a Vantage Virtual Domain. When started, the Virtual 
Domain is fully operational. From the started state, the domain can be paused or 
stopped.

Stopped

One of three main stable states of a Vantage Virtual Domain. When stopped, the Virtual 
Domain instance is terminated, but the “template” for the domain still exists and can be 
restarted.

http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/elastic-ip-addresses-eip.html
http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/elastic-ip-addresses-eip.html
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Vantage Cloud Manager
Vantage Cloud Manager is a client application that you install on your computer to give 
you access to the Vantage applications residing in the cloud. 

Vantage Database Snapshot

A snapshot of a Vantage database from a local or virtual Vantage installation. A 
snapshot taken earlier can be loaded into the Vantage database of the same Vantage 
Virtual Domain or of another Vantage Domain (local or virtual). Snapshots make it easy 
to copy a Vantage database from one Vantage Virtual Domain to another. A snapshot 
does not capture every aspect of a Vantage database, but it does capture these items: 
Workflows, Categories, Stores and Output Folders, Media and Attachment Nicknames, 
Metadata Labels, and Variables, and Run on Rule Variables.

Vantage Domain
A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage 
services, jobs, binders, and configuration settings, all known to and interacting with 
each other, stored in a database. Vantage domains may exist on a single computer or 
they may be distributed across many computers for durability and scalability. The name 
of a Vantage domain is the same as the name of the server that hosts the Vantage 
domain database. Multiple Vantage domains may exist on a network, but they are 
independent entities that do not communicate with each other. 

Vantage Domain Instance
The core components of a Vantage Virtual Domain, including the database and clients.

Vantage Service Instance
The services component of a Vantage Virtual Domain; that is, the transcoding engine 
and other services that provide the available Vantage actions.

Vantage Virtual Domain
A Vantage domain that is provisioned and runs at a Cloud Service Provider End Point in 
a specific Cloud Service Provider Account. Access to the Vantage Virtual Domain is 
provided by the Vantage Cloud Manager application installed on a local Windows 
computer and communicating with the Vantage Virtual Domain via the Internet.

Vantage Virtual Domain Internal Storage
This is the D: drive provided in the Vantage Virtual Domain. This virtual drive is used for 
Vantage Stores.

Virtual Private Cloud (VPC)
When you connect to the AWS cloud, Amazon creates a Virtual Private Cloud (VPC), 
which is your own virtual private network associated with your AWS account. No one 
else can access your VPC; it is completely separate and established just for you. Your 
VPC can be used for launching the cloud applications that you choose to access on 
AWS, such as Vantage Cloud.  
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